In this lesson you will learn how to:
• Create two Type 4 Valuesets (Use Values from Symbols)

• Create a Type 5 ValueSet (Total of other ValueSets)
• Create 2 DataGraphs. Overlay one to display 3 ValueSets
on 1 DataGraph
• Create ValueSet SmartColumns
• Enter Material and Labor ValueSet values for symbols

Lesson 12 - More
ValueSets and DataGraphs

• Add a Substitutable text string to display entered Material
and Labor values as symbol text

Numerical information can be shown along with a schedule. These numerical values are contained in ValueSets. Up to 9 ValueSets can
be added to a schedule. These 9 ValueSets can be graphed on up to 3 DataGraphs, a maximum of 8 ValueSets per DataGraph. ValueSets
values are attached to symbols (e.g. each yellow symbol contains a Labor cost, each blue symbol contains a Material cost). The values on
the symbols can also be totaled in a special ValueSet SmartColumn (e.g. Labor Costs column and Material Costs column).
Type 4 ValueSet values are attached to symbols. When the symbol moves, the values move with them. If the symbols move to a new
time period then the DataGraph changes. If any values, attached to the symbols, increase or decrease, then the column values and DataGraph values also change.
A Type 5 ValueSet can total up to 8 other ValueSets (e.g. Material cost ValueSet is added with Labor Cost ValueSet to get Total Cost ValueSet which can be graphed).

Open the schedule for this lesson.
1. On the toolbar, choose File.
2. In the Files and Templates: Open and Save Options section select
Open Samples or Lessons. The Open a Sample Chart dialog displays.
3. Under Select a Folder below to Open, select Lessons. The Lesson
schedules will display in the window to the right.
Lesson 12 Starter Schedule

4. Pick Lesson 12 Starter Schedule.mlj.
5. Save the schedule to an accessible folder on your computer. Choose
the File tab. In the Files and Templates: Open and Save Options section, choose Save As…. In the menu that displays choose Chart.
Name, then save the schedule.
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Create a Materials and a Labor ValueSet as Type 4: Use Values from Symbols
Material ValueSet
1. Click the Tools tab.

2. In the Graph Options section, choose Set Up ValueSets. The Create or Edit ValueSets dialog box displays.
3. Choose Weekly as the time period to align the values.
4. Click the Create/Edit button to the left of 1: No Name Assigned. The ValueSet
Properties dialog box displays.

5. For ValueSet Name enter Materials.
6. Under the Data Source tab, choose Type 4: Use Values from Symbols as the ValueSet type.
7. Click the Graphic Properties tab to set the ValueSet Display Properties and Graph
Properties.

UNDER ValueSet Display Properties
a. Check on List Numeric Values above or Below Graph to
have numeric ValueSet values display in each time increment above the graph for Materials.

b. Check on Graph Values to graph the Materials ValueSet
values in the DataGraph.
c. Check on Graph as Cumulative to have Materials ValueSet values add together to create the graph.
d. Check on Values Represent Currency and the $ will display on all values for the Materials ValueSet in the DataGraph.
e. Select 0 for Number of Decimals to Display. Numbers
will be shown as whole numbers.
f. Check on Suppress Values of Zero to have zeros not be
listed or graphed.

g. Check on Suppress Leading Values of Zero to have
graph not start at zero and not list a starting zero.
UNDER Graphic Properties
a. Material ValueSet values are going to be graphed as
points (symbols). Under Symbol for Point Graphs: select 2 (a blue diamond). The list of symbols available for
points is a reflection of the toolbox. See tutorial Lesson 4 for more information on setting up symbols in the
toolbox.
b. For Size Override select 1.00. Use this option to override the schedule’s default symbol size for just symbols in
the DataGraph.
The schedule’s default Symbol Size option is found on
8.

Click OK to return to the Create or Edit ValueSets dialog box (keep
this dialog box open for the next set of instructions.)
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the Format tab in the Frame, Highlights section.

Create a Materials and a Labor ValueSet as Type 4: Use Values from Symbols (continued)
Labor ValueSet
1. Click the Create/Edit button to the left of 2: No Name Assigned. The ValueSet
Properties dialog box displays.
2. For ValueSet Name enter Labor.
3. Under the Data Source tab, choose Type 4: Use Values from Symbols as the ValueSet type.
4. Click the Graphic Properties tab to set the ValueSet Display Properties and
Graph Properties.

UNDER ValueSet Display Properties
a. Check on List Numeric Values above or Below Graph
to have numeric ValueSet values display in each time
increment above the graph for Labor.
b. Check on Graph Values to have Labor ValueSet values
graph as bars, lines, or points in the DataGraph.
c. Check on Graph as Cumulative to have Materials ValueSet values add together to create the graph.
d. Check on Values Represent Currency and the $ will
display on all values for the Labor ValueSet in the
DataGraph.
e. Select 0 for Number of Decimals to Display. All Values
for the Labor ValueSet will not show any decimal values.
f. Check on Suppress Values of Zero to have zeros not be
listed or graphed.

g. Check on Suppress Leading Values of Zero to have graph not start at zero and not list a starting zero.
UNDER Graphic Properties
a. Labor ValueSet values are going to be graphed as points (symbols). Under Symbol for Point Graphs: select 1 a yellow diamond. The list of symbols available for points is based on the toolbox. See tutorial Lesson 4 for more information on setting up symbols in the toolbox.
b. For Size Override select 1.00. Use this option to override the
schedule’s default symbol size for symbols in the DataGraph.

The schedule’s default Symbol Size option is found on
the Format tab in the Frame, Highlights section.

c. Under High/Low Graph Connection select Materials to have a
line connect Labor and Materials points.
d. Select a Lines Style of 9 (dashed line) for the line that connects the Labor and Materials points.
e. Select Line/Bar Color of Medium blue to color the line between the Labor and Materials points.

5. Click OK to return to the Create or Edit ValueSets dialog box (keep this dialog box open for the next set of instructions.)
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Create Total Cost ValueSet as Type 5: Total of Other ValueSets
1. Click the Create/Edit button to the left of 3: No Name Assigned to reach the
ValueSet Properties dialog box.

2. For ValueSet Name enter Total Cost.
3. Under the Data Source tab, choose Type 5: Total of other Values Sets as the ValueSet
type.
4. Click the Pick ValueSets to Sum button. The Select ValueSets to Sum dialog box displays.
5. In the Select ValueSets to Sum dialog box check
on 1. Material and check on 2. Labor.
6. Click OK.

7. Click the Graphic Properties tab to Set the ValueSet Display
Properties and Graph Properties.
UNDER ValueSet Display Properties
a. Check on Graph Values to have Labor ValueSet values
graph as bars, lines, or points in the DataGraph.
b. Check on Graph as Cumulative to have Materials ValueSet values add together to create the graph.
c. Check on Values Represent Currency and the $ will
display on all values for the Labor ValueSet in the
DataGraph
d. Select 0 for Number of Decimals to Display. All Values
for the Labor ValueSet will not show any decimal values.
e. Check on Suppress Values of Zero to have zeros not be
listed or graphed.
f. Check on Suppress Leading Values of Zero to have
graph not start at zero and not list a starting zero.

g. Total Cost is going to be a line graph, check on Show
Value Near Point (if shown as Line) to have the Total
Cost ValueSet values display at weekly time increments along the line that graphs.
UNDER Graphic Properties
a. Since Total Cost will be a line graph select Lines Style
23
b. For Line/Bar Color select orange for the color of the
Total Cost line graph.
8. Click OK to return to the Create or Edit ValueSets dialog box. You now have two Type 4 ValueSets and one Type 5 ValueSet, none of which contains values. Choose OK to exit. Nothing visible will be changed on the schedule.
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Create 2 DataGraphs overlaying one to display 3 ValueSets on 1 DataGraph
DataGraph 1 will contain the Total Cost ValueSet values graphed as a line while DataGraph 2 will overlay DataGraph 1 and
will contain Labor and the Materials ValueSet values graphed as points.

DataGraph 1
 Select the Tools tab.
 In the Graph Options section choose Setup DataGraph. The DataGraph Options dialog box displays.

3. Under the DataGraph 1 tab select Assign ValueSets to this Graph button. The Assign ValueSet to DataGraph dialog displays.
4. Check on 3. Total Cost, then click OK.
5. Check on Show this Graph to have the DataGraph display on the schedule.
6. Give a Graph Height of 3.00. Minimum height is .2
7. Total Cost is to be a line graph therefore under Data Display Format choose Lines.
8. For Background Color of the Graph choose light blue.
9. Color Effect for the background choose Fade to Right.
10. To combine two graphs of different Display Formats (in this tutorial, line for Total Cost and points for Labor and Materials) check on Overlay ValueSets from DataGraph 2.
11.Under Y-Axis you can select values for High Number, Increment and Low Number. These values build the Y-axis values
of the DataGraph. For High Number enter 14000. For Increment enter 2000. Leave Low Number at 0.
12.Under Y-Axis check on Include Horizontal Gridlines. For Line Style select 2. For Line Color select medium blue.
13.Check on Plot Numbers Under Graph (instead of above) when Displayed because Materials and Labor ValueSets values
were set to have the Weekly numeric values displayed. Now the values will display below the DataGraph.
14.Check on Extend Frame Shadow into DataGraph area because the starter schedule has a shadow. Keep this dialog open
for the next part of this tutorial.
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DataGraph 2
1. Select DataGraph 2 tab.
2. Under the DataGraph 2 tab select Assign ValueSets to this Graph button. The Assign ValueSet to DataGraph dialog displays.
3. Check on 1. Materials and 2. Labor, then click OK.
4. Check on Show this Graph to have the DataGraph display on the schedule.
5. Material and Labor values are to be points on the DataGraph therefore under Data Display Format choose Points.
No formatting for the DataGraph 2 looks needs to be chosen because in DataGraph 1 the option Overlay ValueSets
from DataGraph 2 was selected. Thus the information from ValueSets Material and Labor will be overlayed onto
DataGraph 1. Two DataGraphs are being used to distinguished the Data Display Format, for Total Costs the data will
display as a line, as selected. Material and Labor data will display as points, as selected.
6. Click OK to return to the schedule, the DataGraph will display without any values. Values will be added in the following
pages.

DataGraph Added to Schedule
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Create ValueSet SmartColumns (total the symbol values by row)
ValueSet SmartColumns sum specified ValueSets for each task row. The columns currently on the schedule labeled Material
and Labor cost need to be changed to ValueSet SmartColumns and assigned the corresponding Symbol ValueSet. Then the
symbol values that will be entered will total and populate for each task row in the assigned column. Even though the All
Projects task row has no symbol values entered, as a summary level task it will populate with the totals of the lower level
costs.
1. Click the Material Costs column heading. The toolbar will change to the Selection tab with Current Object: Column
Heading. On the left side of the toolbar select Switch to Column.
2. In the Column Type and Format section click the
down arrow in the field showing
(none). From the displayed menu choose ValueSet. The ValueSet Options dialog box displays.

3. For ValueSet to Use, choose 1. Materials select OK.
4. On the toolbar in the Column Type and Format section set the columns values Decimal Places to 0.
5. Check on Currency to show a $ sign next to each cell value in the column.
6. Now do the same for the Labor Cost column. Select 2. Labor in the ValueSet Options dialog.
No values will be in the columns yet. You will add the values in the next step. Note that the
first column cells show $0, reflecting the selections for ValueSet and currency with no decimal point.

Schedule with ValueSet SmartColumns
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Enter Material and Labor ValueSet values for symbols
For each symbol, you can enter a value for Material ValueSet and/or Labor ValueSet. In this lesson, you will enter Labor cost
values on the yellow symbols, and enter Material cost values on the blue symbols, in keeping with the color scheme of the
columns and DataGraph.
1. Click the () Arrow tool in the Toolbox.
2. On the Project A task row select the first blue symbol, the toolbar changes to the Selection tab with Current Object:
Symbol

3. At the bottom of the toolbar choose the ValueSets tab.

4. In the Material slot enter 300 as the value for this symbol, press the

apply button.

5. On the Project A task row select the next symbol which is yellow. You will not have to reselect the ValueSets tab it will
stay active.
6. In the Labor slot enter 600 as the value for this symbol, press the

apply button.

7. Continue adding values using the matrix below. Enter Material cost values on the blue symbols. Enter Labor cost values
on the yellow symbols. IMPORTANT, after entering a value choose the
apply button.
Project A
Materials: 300, 400
Labor: 500, 2000

Project B
Materials: 300, 600, 500
Labor: 800, 1000

Project C
Project D
Materials: 500, 300, 500 Materials: 300, 300, 200
Labor: 500, 700, 300, 500 Labor: 600, 200

As each value is entered the DataGraph and the column values change.

Schedule with DataGraph and ValueSet SmartColumns Populated
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Project E
Materials: 200, 400, 200
Labor: 500, 300, 600

Add a Substitutable Text String to symbols to display entered Material and Labor values as symbol text.
1. Click the () Arrow tool in the Toolbox.
2. On the Project A task row right click the first blue symbol.
3. On the menu that displays select, Select all
Instances of this Symbol Type. All blue symbols will highlight with a box around them
and the toolbar will change to the Selection
tab Current Object: Symbols (15 Selected).
4. At the bottom of the toolbar select the Text
tab.
5. In the Text section next to Line 1: enter &vs1.
6. Then press the
Apply Text Changes button. Now all
blue symbols will have their Materials ValueSet value
displayed as symbol text.
&vs1 is a substitutable text string that tells Milestones to
add the values for the specified ValueSet (1-9) as symbol
text. The background look of the symbol text is set for
each symbol in the toolbox. Double click the symbol in the
toolbox. Select the Text/Date Properties tab. See the Text
Background Box selections.

7. On the Project A task row right click the first yellow symbol.
8. On the menu that displays select, Select all Instances of this Symbol Type. All yellow symbols will highlight with a box
around them and the toolbar will change to the Selection tab Current Object: Symbols (14 Selected).
9. At the bottom of the toolbar select the Text tab.
10.In the Text section next to Line 1: enter &vs2.

11.Then press the
symbol text.

Apply Text Changes button. Now all yellow symbols will have their Labor ValueSet value displayed as

Substitutable Text String Adds ValueSet Values as Symbol Text
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